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Before we Begin |

AEM Forms Designer was previously called LiveCycle Designer and this training course supports all of the versions
from LiveCycle Designer ES2 to the current version of AEM Forms Designer. Despite the name change, the program
has stayed the same. The greatest changes to the program occurred between LiveCycle Designer ES2 and LiveCycle
Designer ES4. To make things simple, we will refer to the various versions as simply Designer for the remainder of
this class.

Environments:

You must have a copy of the AEM Forms Designer software to do the exercises in this class.

Prerequisites:

None.

www.aemforms.training

The support site (www.aemforms.training) is designed to support our students during and after a training session.
Here is what you will find on the support site.

— The Known Issues section documents bugs and issues with various versions of AEM Forms.
— The Sandbox section lists AEM Forms Servers you can use for the hands-on exercises.

— The Forum section enables you to post, review, and answer questions about AEM Forms.

Limited Courseware License

This Student Training Manual and related COURSEWARE is property of SmartDoc Technologies LLC (SMARTDOC).
SMARTDOC retains all right, title and interest (including, without limitation, all patent, copyright, trademark, trade secret
and other intellectual property rights) in and to the COURSEWARE. SMARTDOC grants a limited and non-exclusive
license to a STUDENT to use the COURSEWARE under one of the following conditions.

— STUDENT is an active SmartDoc subscriber. Once a STUDENT'S SmartDoc subscription has elapsed, STUDENT is
no longer licensed to use this COURSEWARE.

— STUDENT is registered in a training class taught by SmartDoc Technologies.

— STUDENT has received a trial SmartDoc Subscription. Once the trial has elapsed, STUDENT is no longer licensed
to use this COURSEWARE.

Students can use the COURSEWARE for their own study but cannot use these materials to teach training courses.
Any use of the COURSEWARE by STUDENT for any purposes beyond self-study must be agreed to by SMARTDOC in
writing prior to the usage and will require a $400 per day group license fee for each course. Each personalized
SmartDoc Subscription and each limited COURSEWARE LICENSE must only be used by the STUDENT and is not
transferrable. All rights not granted by SMARTDOC are reserved. STUDENT acknowledges that they have obtained
only a limited license right to use the COURSEWARE.
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Introduction to Designer |

Designer is a Microsoft Windows-based program that provides all the tools you need to create basic or sophisticated
forms. You can create PDF or HTML forms with Designer. Designer is a multifaceted tool that supports the four most

important requirements of smart forms:

—  Multiple format and device support: With the new version of Designer, you can create one Designer file and
render it in all the formats you need for your business. These formats include HTML, interactive and dynamic

PDF forms, and read-only PDF documents. Your Designer forms and documents can be used on traditional PCs

and Macintoshes and also on tablets and smartphones.

— Data handling: Designer makes it easy to get data structures into your forms and to output properly formatted

data from your forms. Powerful tools are provided for data validation, data formatting, and data binding,

— Scriptable interactivity: Designer’s scriptable interactivity goes way beyond what is available in Acroforms and

other form technologies. Virtually every form object is scriptable at any step in your process. Designer has a
sophisticated object model, which you can use to add powerful interactivity to your forms.

— Graphic precision and fidelity: The three preceding features would usually be enough for an interactive forms
tool, but Designer also offers the graphic precision and quality of an Adobe solution. For the last 30 years, Adobe

has been the unquestioned leader in computer graphics with industry leading products in graphic design,

marketing, and digital publishing tools. You don't need to compromise on typography, layout, or graphic quality

with Designer forms, and your one form can be used for all your business needs.

The Workspace

The workspace consists of many editors, views, and palettes. These palettes can float or be docked like they are on

the right. You can configure your workspace in many different ways. This illustration shows a very common
configuration of a Designer workspace with each of the major sections labelled.

Designer’s interface showing each of the major sections.
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The Layout Editor

The Layout Editor is in the middle of the workspace, and it contains five main views: Design View, Master Pages,
XML Source, Preview PDF, and Preview HTML. You'll see the Layout Editor when you have a document opened. The
following is a brief introduction to each of the Layout Editor views:

Design View: Design View is the main view in the Layout Editor and the one that you'll use the most. This view
displays a WYSIWYG view of your form and allows you to edit many of the visual properties of your form objects
directly.

Master Pages: The Master Pages tab shows an independent view of your master pages without any body page
content. Master pages contain content areas that define the outer boundaries for body page objects.

XML Source: If you don't see the XML Source tab, you can select it in the View menu. This is your form in XML
format. The structure of Designer forms is all XML, and as you make additions and edits to your form in Design
View, this XML is updated in the background. You can quickly locate the XML source code for any of your form
objects by selecting the object in the Hierarchy palette while the XML Source view is open. You'll immediately
see the XML Source view update, and your selected form object will be highlighted in the XML Source view.

Preview PDF: You can preview your forms directly in Designer by switching to the Preview PDF tab. This tab
uses your computer's default PDF viewer, so if you have Acrobat, you'll notice part of the familiar Acrobat
interface wrapping around your form when you view it in this tab. You can see more of Acrobat by pressing
Alt+F8.

Preview HTML: If you don't see the Preview HTML tab, you can select it in the View menu. If it doesn't appear
in your View menu, you're likely using a version of Designer prior to Designer ES4. You'll learn how to configure
and use this view in, “HTML Forms."

The Left Palettes

The area on the left includes palettes you'll use to organize the structure of your form:

Hierarchy: You'll spend a lot of time using this palette to view and organize the objects and structure of your
form. When you select an object on your form, it's also selected in the Hierarchy palette, and vice versa. The
Hierarchy palette displays your form'’s objects in a tree view, which is a great way to examine and edit your
form's structure. Understanding this structure becomes particularly important when you start adding script to
your form. The Hierarchy palette also displays referenced objects under the Referenced Objects node. A
referenced object is an object that's added to a form only when it's required. Overflow leader and trailer subforms
are examples of referenced objects. Whenever data flows across multiple pages or content areas, the overflow
leader and trailer subforms are inserted into the form in the appropriate places.

PDF Structure: This palette does not appear in the previous figure, but is available in Designer. It isn't usually
relevant for the XML Forms Architecture (XFA) PDF forms you'll create with Designer. It's more relevant for
Acroforms and PDF documents because it displays a hierarchical view of the accessibility tags in these types of
PDFs. You'll use this feature in Designer if you're working with PDF forms with fixed pages and fixed background
artwork. You add accessibility features to XFA PDFs with the Accessibility palette.

Data View: When you open a form that's connected to a data source, the Data View palette shows you a
graphical representation of your form’s data elements. You can associate your forms with data sources through
a process called data binding. You can bind your form objects to an XML Schema, a Sample XML Data file, an
Adobe Data Model, a WSDL (Web Services Description Language) file, or an OLEDB (Object Linking and
Embedding Database).

Tab Order: The Tab Order palette shows all your form objects in a list that corresponds to the order that a user
will see when tabbing through the form. You can change your form'’s tab order with this tool. The default tab
order for Designer forms is left to right and top to bottom. If you don't see this palette, choose Window - Tab
Order.
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The Data View palette showing the schema binding on the SmartDoc Expense Report form.

The Right Palettes

The area on the right includes palettes you'll use to create and edit your form objects:

— Font: The Font palette enables you to edit the font family, size, and style of text in your objects. Many interactive
form objects like Text Fields have both a caption and a value font property that can be set independently.

— Paragraph: The Paragraph palette enables you to edit the alignment, indents, and line spacing of your text.

— Object Library: The Object Library palette provides a collection of all available form objects. You can easily drag
and drop form objects from this palette onto your form layout.

— Fragment Library: The Fragment Library palette provides a collection of your form fragments. Form fragments
are reusable form parts that are saved as separate files. These fragments are ideal if you're creating or managing
numerous forms that use the same form parts.

— Object: You use the Object palette to modify the properties of your form's interface objects. As you work with
this palette, you'll learn that it's very useful and very adaptive. It enables you to edit and customize the most
important aspects of your objects without having to provide any custom JavaScript. It's flexible because it
reconfigures its options based on the object you select. For instance, if you select a master page object, you'll see
the Master Page and Pagination tabs on the Object palette.

— Layout: The Layout palette works hand in hand with the Layout Editor. As you make changes to your object in
the Layout Editor, they are reflected here, and vice versa.

— Border: Most of the information in the Border palette is self-explanatory. However, it's important to note that
these border properties affect the entire object, not just the editable portion of the field. The entire area
surrounding your field and caption will be outlined with a border that you set with this palette. If you want to
edit the border around your field, use the Appearance property on the Field tab of the Object palette.

— Accessibility: You can use the Accessibility palette to set Screen Reader properties for your forms. You can set
several different options for each field on your form; you'll learn more about this later.

Text Field : ! Border palette

| The Appearance property on the
‘ Field tab of the Object palette
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The Border palette settings outline the entire object, but the Appearance property in the Object palette enables you
to outline just the field.

The Script Editor

By default, the Script Editor is located directly above the Layout Editor and below the menu bar. You use this tool to
create and edit scripts, and it's usually docked at the top of the Designer workspace. Scripts are an important part of
smart forms because they enable you to customize the functionality of your forms at both the client and the server
level. You'll learn more about this later in the manual.

The Report Palette

By default, the Report Palette is located directly below the Layout Editor, and it's usually docked at the bottom of the
Designer workspace. This palette displays messages about your Designer file so you can correct issues as you work.

Adobe XFA and XDP

Designer creates forms based on the Adobe XML Forms Architecture (XFA). You will save these forms as XML Data
Packets. (*xdp). Designer forms can be rendered as many different types of PDFs and also as HTML forms. Designer
enables this flexibility because it creates well-structured XFA to describe each aspect of your form. For instance, this
is the well-structured XFA that describes a Text Field.

[ Design View Master Pages | XML Source =T Preview PDF =) & Preview HTML =
<field name="TextFieldl" y="31.75mm" x="19.05mm" w="62mm" h="0mm"> o
<uix
<textEdit>

1

<border>
<edge stroke="lowered"/>
</border>
<margin/>
</textBEdit>
<fui>
<font typeface="Rdobe Clean"/>
<margin topInset="1mm" bottomInset="1mm" leftInset="1mm" rightInset="1lmm"/>
<para vAli iddl >
<caption
<para
<value>
<text>Text Field</text>
</value>
</caption>
</field>

Saving

When you save your Designer file, you need to consider how it will be used. The following is a list of file format
options available in Designer. You'll learn how and when to use these formats throughout the training.

File Formats

— Adobe Static PDF Form (*.pdf): Saves forms as static PDFs based on the Acrobat and Adobe Reader target
version specified in the form properties. Even if you specify a dynamic, flowable layout, this type of PDF form
will still be static and will not re-render in response to user action. The fields on this form type can be interactive
or non-interactive.

AEM Forms Designer - 10 © 2019 SmartDoc Technologies



— Adobe Dynamic XML Form (*.pdf): Saves forms as dynamic PDFs based on the Acrobat and Adobe Reader
target version in the form properties. In this case, a dynamic, flowable layout will re-render in response to user
action. A user can add or remove table rows and even entire form sections with this type of PDF.

— Adobe XML Form (*.xdp): Saves forms in the native XML-based file format created by Designer. Use this option
if you'll be using an AEM Forms Server to render PDF or HTML forms. The form design can contain dynamic and
interactive elements.

— Adobe Designer Template (*.tds): Saves the basic structure for a form as a template. It can contain
components and settings, such as fonts, page layout, formatting, and scripts. Use it as a starting point for a new
form.

— Adobe Designer Style Sheet (*.xfs): Saves the internal style sheet in the form as an external style sheet. Style
sheets can be used to provide consistent formatting to all your forms. Style sheets can control the look of
caption and field value text, the appearance of object borders and background colors, as well as the size and
style of Radio Buttons and Check Box objects.

Options for PDFs

When you create a PDF, Designer provide a few additional parameters. You can select these parameters in the Form
Properties dialog. Select File - Form Properties - Save Options.

Form Properties @
Info PDF
Defau.lts | Generate Accessibility Information (Tags) for Acrobat
Rurn-time
Formatting Generate Log File When Saving
Default Fonts
Form Validation /|Embed Fonts
Server
Variables

These options apply only when saving form designs as PDF files. They do not apply
& o PDF files rendered using LiveCycle Forms ES or documents rendered using
LiveCycle Output ES.

FDF Security
FDF Print Options
Compatibility
Preview

Data Binding

This is a summary of each option, and you will see more details in the training,

— Generate Accessibility Information (Tags) for Acrobat
This option is necessary to make your PDF forms accessible for devices like screen readers.

— Generate Log File When Saving
This option will generate a log file which you can view in your Report palette.

— Embed Fonts
This option will put specific font information in your PDF file. On one hand this is beneficial because you can be
assured that your fonts will render properly on a form-filler's machine. On the other hand, selecting this option
makes your file much larger, which results in longer download times for your user. The performance advantage
of smaller PDF forms is so substantial that you should think twice before choosing to embed fonts.

Standard Objects

Designer includes a library of standard form objects. These objects can be added to your form by dragging and
dropping from the Standard Object Library to the Layout Editor.

© 2019 SmartDoc Technologies AEM Forms Designer - 11
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Text objects and Text Field objects

These are often confused by new students. The Text object is simply static label text. You can use it for labels or for
paragraphs of text. It is possible to make Text objects dynamic by introducing floating fields.

Text Field objects are interactive and dynamic. They provide users with a way to enter data on the form. Text Field
objects support all the following features.

— Captions and interactive data entry fields
—  Multiline text
— Display and validation patterns

— Rich Text

Numeric Field objects

Like Text Field objects, Numeric Field objects should be used when you need to collect or display data. However,
unlike Text Field objects, Numeric Field objects should be used for numeric data like floats, integers, and currency
values. The following are characteristics of this object type.

—  Numeric fields only accept numeric input.
—  Numeric fields support display and validation patterns.

—  Numeric fields are context-sensitive to the Locale setting. A U.S. Locale setting will use a comma to denote
thousands (1,000.) while a German Locale setting will use a decimal point to denote thousands (1.000).

Image objects and Image Field objects

These objects are like Text and Text Field objects because an Image object is also static, and an Image Field object is
also interactive. If you need a static image on your form, use the Image object. If you need an image that the user can
change at runtime, use the Image Field object.

Dropdown List objects

A Dropdown List is an ideal form object for an enumeration or an array. It displays a list of items and facilitates the
user’s selection of an item from the list. Consider these points about a Dropdown List.

— It accepts custom user entries.

— Although it initially displays only one item, once it is selected, it shows the entire list.

AEM Forms Designer - 12 © 2019 SmartDoc Technologies



List Box objects

A List Box is like a Dropdown List because it can display a list of items and facilitate the user’s selection of an item
from the list. However, keep the following points in mind when considering the use of a List Box.

— It requires more form real estate than a Dropdown List.

— It does not accept custom entries from the user.

Button objects

Designer's standard Button object can be configured for any action your form may need. You can set the Control
Type to Regular and write JavaScript on the click event to perform the functionality. Or you can set the Control Type
to Submit to configure a form submission. Here is a short summary of Control Types for the Button object.

—  Select Regular for the Control Type to run the JavaScript in the click event.
—  Select Execute for the Control Type to execute a database query or call a web service.

—  Select Submit for the Control Type to submit the form’s data to a web service or other endpoint.

Specialty Button objects
In addition to the standard Button object, Designer also has these specialty Button objects.

—  The Print Button initializes the Print Dialog box.

The E-mail Submit Button submits the form to a specified email address.

—  The HTTP Submit Button creates an HTTP submission of the form to a specified URL.

The Reset Button removes all the data input from the form.

Radio Button objects and Check Box objects

Radio Buttons objects are part of an exclusion group, but Check Box objects are not. Therefore, you will likely use
Radio Button objects in cases of mutually-exclusive choices and Check Box objects in cases where one or more
choices can be selected. You can set the style of either object to be a square or a circle. You also have a variety of
check styles for each object.

Date Field objects

The Date Field object presents the user with a visual calendar dropdown to select the date. Once selected, the date is
automatically formatted according to the Display Pattern property of the object.

Date Field |‘IO/30 1 October, 2019 ’ °

Sun Mon Tue Wed Thu Fri  Sat
29 30 1 2 3 4 5

PB Blen 12
[ Today: 11/26/2019

Date Field |Wednesday, October 30,2019

Display Pattern
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Signature Field objects and Signature Scribble objects

In short, the Signature Field object is used for PDF forms and the Signature Scribble object is used for HTML forms.
The Signature Field object requires the end user to have a valid Adobe Acrobat digital signature to sign. The Signature
Scribble object can be signed simply by scribbling a signature with a mouse or a stylus. If the end user has a touch
device like an Apple iPad, they can sign the Signature Scribble object with their finger.

Exercises

Work with Objects

In this exercise you will be adding the different interactive elements to your form. You will be setting certain
properties for each of the elements so that the element is relevant and works well in your form.

1. Open the Designer software if it is not already open.

2. Select File - Open and navigate to your Student Files.

3. Select ExpenseReport2020_startxdp and click Open.

4. Select File - Save As and navigate to your working folder. Note: This can be a folder of your own choosing.
5. Enter <yourname>ExpenseReport<year>.xdp as the File name.

6. Click the Save As type dropdown and select Adobe XML Form (*.xdp).

7. Click Save.

8. Select File - Form Properties.

9. Enter <yourname> Expense Report <year> for the Title.

10. Enter This is my exercise file from the SmartDoc training class for the Description.

1. Enter <yourname> for the Author.

Form Properties @

I File: CA\A - DOE May 2021\jptExpenseReport.xdp
Defaults

Run-time

Formatting Title: JPT Expense Report 2021

Default Fonts Description: This is my exercise file from the SmartDoc training class.
Form Validation

Server

Variables

PDF Security

FDF Print Options

Compatibility

Preview :

Save Options Author: 1P, Terry Creation Date:
Data Binding Contact: Version:

Note: This metadata will appear in AEM dfter the XDP file is uploaded to an AEM Server.

12.  When you are done, click OK.

13. Expand your Drawing Aids palette. If you don't see your Drawing Aids palette, you can select Window -
Drawing Aids to display the palette.
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14.

15.

16.

17.

Select View - Grids & Guidelines - Show Grid (see illustration).

Select View - Grids & Guidelines - Snap to Grid (see illustration).

m Designer - [ExpenseReport2020_startxdp]
™ File Edit Insert Table Layout
oOH~=a Rulers

Grids & Guidelines

Objects

Object Editor

Subform Indicators

Table Visual Aids

Hierarchy El( v
Q v
v

— Design Vi
=-[E] expenseR FLOED
. Master Pages
XML Source
1 pag Preview PDF
=5 pagel  preview HTML
I—gie ]

Tools Window Help

N F @ 0% > @&

v+ Show Grid Ctrl+'
*| ¥ Snapto Grid Shift+Ctrl+'
Show Guidelines
Snap to Guideline es =ML Source  Erevie
t 4
F5 - 8martDoc Expense Report
F4 T e

Notice that the X Interval is set to 16/in, and the Y Interval is also set to 16/in. This will produce a 1/16-inch grid.

Close your Drawing Aids palette now by clicking the small X in the top-right corner of the palette.

18. Drag and drop a Text Field object from the Standard Library to the employee subform on pagel (see illustration).

| Hierarchy 5" Data View

[] Design View

| Master Pages

X | [« XML Source

X

Q|

=-[E] expenseReport
*@ masterPages
El|j pagel
él = mployee
Linel
[ eieia
HPENSes
expensas\Wrapper
@ columnHeaders
B@ expenseRow
H delrow

..... I=‘§3 date

19.
Object Palette.

20.
21. Click the Field tab.

22.
box will open.

23.

24,

© 2019 SmartDoc Technologies

Select the Binding tab and enter email as the Name for the object.

Click the Edges dropdown and select Edit Together. This should be the default.

Click the next dropdown and select Solid for the Edges (see illustration #2).

With the Text Field selected, enter Email for the Caption property. This property is located on the Field tab of the

Click the Appearance property dropdown and select Custom (see illustration #1). The Custom Appearance dialog
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( — |
Custom rance X
| Object E\Layout \l\ Accessibility \Border Appea —
- — Borders
J Field \Value \Bmdmg Edges: Edit Together -
Type: []Text Field
yPe e ” O solid : 0.006%in £ v
Caption: Email None
Appearance: Sunken Box l:] Dashed
None
DAHOW r Underlined e
|:|Limit Let 5glid Box
[C]Limit Let Sunken Box
Allow Pi
v
Keep iy

25. Enter 0.0125in for the line size and select Gray-25% for the color (see illustration below).
26. Select a round corner and enter 0.05in for the Radius.
27. Click the Background Fill Style dropdown and select Solid.

28. Select White for the Fill Color (see illustration below on the right).

Custom Appearance @ Custom Appearance @
Borders Borders

Edges: Edit Together - Edges:  Edit Together v
[ solid ~ 0.0125in [ solid v 0.0125in v

EEEEEEEN
HEEEEEEEN
| EEEEN
O HEERE
-25094
corners: [ |r|r Radius: More Colors Gray EE corners: I IJ_IJ- Radius: 0.05in .
ENEEEEEN
|:|Dmit Border around Page Breaks |:|Drnit Border around Page Breaks EEEEEEEDR
Background Fill Background Fill | HEEENEN
Style:  Solid v+ &~y h~ Style:  Solid ~+ &~y N EEEN
More Colors... |
[ oK ] ’ Cancel ] oK l ’ Cancel ]

29. Click OK when you are done.

30. Select Limit Length in the Field tab of the Object palette.
31. Enter 255 for Max Chars. This should be the default.

32. Select the Value tab of the Object palette.

33. Click the Type dropdown and select User Entered - Required. This will make this field mandatory.

| Object @\Lavout \l\ Accessibility \I\Border

Field 1 value Binding

Type: User Entered - Optional lll

User Entered - Optional
Defz

User Entered - Recommended

User Entered - Required
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34. Select the Layout palette. If you don't see the Layout palette, select Window - Layout.

35. Select the Caption Position dropdown and change the value from Left to Top (see illustration).

| Object j Layout IEN\Bl:urder

Size & Position

Marains || =ft
Right .
Left: Top: Qin
e Top op
Right: Bottom Bottom: | Oin
Caption Mone |
Position: | Top |v Reserve:

36. Enter 0.25in for the Caption Reserve.

37. Enter Oin for each of the four margins.

38. Enter .5in for X and 1.1875in for Y.

39. Enter 2.4375in for Width and 0.5625in for Height.
40. Open the Font palette if it is not already opened.

41. Click Currently editing Caption and Value properties in the Font Palette and select Edit Caption.

*

| Font Izl\l\ Paragraph =
Currently editing Caption and Value... L4

Myriad Pro - ' 10 |« EditCaption and Value
syje: B v | I | U = | e ~ |[&]__Edit Caption |

Edit Value
e ——
A% Opt [T 100%
AY o I 100%

42. Click the font dropdown and select Arial.
43. Click the size dropdown and select 10pt.

44. Click the color dropdown and select Gray-80% (see illustration).
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* x
| Font 121\1\ Paragraph =
Currently editing Caption properties... L

Arial - T 1
Style: B "| I 'lgv|”‘ﬁev|
EEEEEEEE
AL Opt IT 100% IIIIIII$7
[ [ ] B | Gray—SO'?-'c l
¥ 0T o, —
“% 0 A, 100% - E
Dﬂutn Kern
More Caolors... | x

45. Click Currently editing Caption properties in the Font Palette and select Edit Value.
46. Click the font dropdown and select Georgia.
47. Click the size dropdown and select 10pt.

48. Click the Edit menu and select Copy Multiple (see illustration).

(A} Designer - [jptExpenseReport2024.xdp]
"™ File Edit View Insert Table Layout Tools Window Help

mixed Undo Script Change Ctrl+Z = = = D ~ [r [j | H | % | | [__‘:
Redo Script Change Shift+ Ctrl+Z |
Cut Ctri+X ———

Copy Chil+C Design View jter Pages ® Source ®iew PDF =

Paste Ctrl+V
Delete Del

Delete Page

Duplicate Ctrl+D

Copy Multiple...

49. Enter 2 for Number of Copies.
50. Select No Vertical Movement (see illustration).
51. Select Place to the Right (see illustration).

52. Select Offset By and enter 2.5in (see illustration).

Copy Multiple X
Mumber of Copies: E

Vertical Placement Vertical Spacing

(") Place Above Touching

() Place Below Offset By: 0.6875in

(®) Mo Vertical Movement

Harizontal Placement Harizontal Spacing
() Place to the Left (O Touching

(®) Place to the Right (®) Offset By:

(C) Mo Horizontal Mavement

Cancel
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53.

54.

55.

56.

57.

58.

Click OK and 2 new fields will be created.

With all three fields selected, click Edit - Copy Multiple again.
Enter 1 for Number of Copies.

Select Place Below for Vertical Placement.

Select Offset By and enter .6875in for Vertical Spacing.

Select No Horizontal Movement. Your settings should look like this.

Copy Multiple

Mumber of Copies:

Vertical Placement

() Place Above

(®) Place Below

() Mo Vertical Movement

Harizontal Placement

Vertical Spacing
(C) Touching
(®) Offset By:

Haorizontal Spacing

() Place to the Left Touching
(C) Place to the Right Offzet By: 2,5in
Carcel

s

59. Click OK.

60. Move email[5] up in the Hierarchy palette so it becomes your second email field. This action should re-order

your fields in the Hierarchy panel to match their order on the form (see illustration).

=
Herarchy &
o O I | 3

=-[E] expenseReport
{3 masterPages

gel
£1{5 employee

iE expenses

- expensesWrapper

w-F columnHeaders

E-E expenseRow
delrow

D date
-F] category

. SmartDoc Expense Report ... ... ...

o |Emall o

..,|\'°E.ma.il.. EEEERERE

Email - oo

O

©.9

description

Week Of:

Category

Description

Amount

d

Meals ]

61. Right-click the email[1] item in the Hierarchy palette and select Rename Object.

62. Enter firstName for the name. Notice that the remaining email fields have been renumbered in the hierarchy.

63. Select the Field tab of the Object palette and enter First Name for the caption.

64. Right-click the email[1] item in the Hierarchy and select Rename Object.

65. Enter lastName for the name.

66. Select the Field tab of the Object palette and enter Last Name for the caption.

67. Right-click the email[1] item in the Hierarchy and select Rename Object.

© 2019 SmartDoc Technologies
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68.

Enter reportName for the name.

69. Select the Field tab of the Object palette and enter Report Name for the caption.
70. Right-click the email[1] item in the Hierarchy and select Rename Object.
71.  Enter clientName for the name.
72. Select the Field tab of the Object palette and enter Client Name for the caption.
73. Right-click the email[1] item in the Hierarchy and select Rename Object.
74. Enter total for the name.
75. Select the Field tab of the Object palette and enter Total for the caption. Your form should now look like this.
I A I T S A M
{0 masterPages |
5 G g‘f;pmm Email First Name Last Name
T tinet .
{] email . .
[ firstName S I
] tasthame Report Name Client Name Fotal Jj :
1] reportName
L] clientMame s
12 cptnee
T et -
& . ZZT;RV:W Week Of: Category Description Amount
_@ ate
bers 3 st ]
76. Select clientName and change the Type to Dropdown List. The Type property can be found on the Field tab of

77.

78.

the Object palette (see illustration).
Click Add (the plus icon) on List Items (see illustration).

Enter Walmart as a List Item in the new Dropdown List.

Object IZI\]\Layout \I\Border \l\ Accessibility

J Field \]\Value \I\Binding

Type:

Caption:

Appearance: Custom...

.;‘EDrop-down List

Client Name

List Irems: A= &
Text |mi
walmart |
79. Click Add (the plus icon) again and add Amazon, Target, Costco, Home Depot as List Items. You will need to

80.

81.

AEM Form

click Add each time to enter a new list item.

Select total and change the Type to Numeric Field. The Type property can be found on the Field tab of the
Object palette.

Click the Patterns button on the Field tab of the Object palette.
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82. Make sure the field has a useful Display Pattern. Here is one suggestion: num.currency{}

83. Click OK.

84. Select your Email field and open the Binding tab of the Object palette.

85. Notice the Data binding property is set to Use name (see illustration).

| Object IZI\I\Layout \Border \Accessibilit}'

Field j Value :| Binding\

Mame: | email || ] |

n
b

Diata Binding (Open, Save, Submit):
| Uze name (email)

86. Also check the other fields to confirm their binding is set to Use Name.
87. Select File - Save.

88. Click Preview PDF to see your form in action.

89. Enter values for your fields.

You should see something that looks like this (see illustration).

SmartDoc Expense Report
Email First Name Last Name
jp@smartdoctech.com James Terry
Report Name Client Name Total
Adobe Training for Target Target H $300.00
almart
JAmazon
Week Of Category Larset Al t
eek Of: atego Costco moun
Home @
Meals v
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Now that you know where everything is, let's review some important concepts about dynamic forms: master and
body pages, subforms and flow, and tables. These are usually the concepts that trip people up when they start
creating Designer forms. By mastering these ideas early, you'll avoid many pitfalls when designing and
implementing your forms in the later exercises.

Examples

Dynamic Forms will grow or shrink based on data or user interaction. We will review a Dynamic Expense Report
(see illustration) that will grow or shrink depending on the amount of expense items. Each new expense item will be
represented by a new expense row. And we will review a Dynamic Insurance Form that will change options based
on the type of policy a user selects.

SmartDoc tecunoLoaies

Dynamic Expense Report Form

Date Requested: 6/8/2021

Employee
First Name Last Name SmartDoc Client
Notes
Expenses
Receipt Date Category Description Cost #of Total
[+ I 9 :

Add Expense

Master and Body Pages

Designer documents consist of master pages and body pages. Master pages define the layout and background
elements of your form. You should put common page items like page numbers, repeating logos, and footer
information on your master pages. Body pages should contain all the form objects that are unique to a particular

page.
When you're working with multipage forms, it's quite possible that you'll need a different look and feel on different
pages. For instance, an account opening form may require three pages of interactive objects and six pages of legal
text in columns. In this case, it makes sense to define two different master pages: one for the body pages with the
interactive objects and one for the body pages with the legal text.

Master pages

You edit your master pages in the Master Pages tab in the Layout Editor. If you don't see this tab, choose View -
Master Pages. Every Designer file must have at least 1 master page. The SmartDoc Expense Report (from the Student
Files) has two master pages. The first master page (masterPagel on the left) contains the document's header on the
top. The second master page (masterPage2 on the right) contains automatic page numbering on the bottom.
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SmartDoc recunoosies™ ExpenseReport _1____ Te)(t an d | m age (0] bj E'CtS

uuuuuuuu

— Content areas

Automatic page numbering ~_|

@ Copyright 2020 - SmartDoc Technologies

@ Copyright 2020 - SmartDoc Technologies  Page2 of 2

— Text objects —

Both master pages contain Content Area objects which are the pink boxes. These objects define the outer bounds of
the layout area for each associated body page. Content Area objects are particularly important for dynamic forms
with flowing content. In the SmartDoc Expense Report form, the content area on masterPage2 is larger than the
content area on masterPagel. This larger content area means the body pages associated with masterPage2 can
display more information than the body page associated with masterPagel. Content Area objects are regular
Designer objects and are found in the Standard Object Library palette.

The SmartDoc Expense Report is a dynamic form, and a dynamic form can grow to accommodate every data item.

Whether it has 1 page or 1000 pages, it will always have one instance of masterPagel. This is achieved by setting the
Restrict Page Occurrence property on masterPagel as shown in the illustration on the left. So, the master page with
the logo and header will only appear once and will always appear once, on the first page.

However, notice in the illustration on the right that masterPage2 doesn't have any page restrictions. Since it is the
next master page in the hierarchy, it will be used for page 2 and for all subsequent pages in the dynamic form.

% %
Object & = | object = .
J Master Page \Paglnatlon J Master Page \Pagmatlon
Name: | masterPagel Name:  masterPage2]
Paper Type: Default - Paper Type: Default -
Height: | 11in Width: | 2.5in Height: | 11in Width: | 8.5in
Orientation (@) Portrait (_) Landscape Orientation (@) Portrait () Landscape
Restrict Fage Occurrence D Restrict Page Occurrence
Mm Count: 1 Max: 1 Min Count: Mane:
Presence: Presence:
Visible v Visible v

Most of your form objects will be placed on body pages. Each body page will reference a master page. You can view
your body page objects by switching from the Master Pages tab to the Design View tab in Designer. Body pages are
subform objects in Designer and as such are treated just like any other subform.
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Subforms and Flow

A subform is a container for 1 or more form objects. Subforms define the structure of your form, and you can nest a
child subform inside a parent subform. In fact, there’s no limit to the nesting you can do with subforms. Subforms in
Designer (left) are like panels in AEM adaptive forms (right).

- x
| Hierarchy IZN\ Data View \Tab Order = < — )
N R “ ~ —  Form Container EXPAND ALL
=I[=] expenseReport - —
54T (Master Pages) ‘\ ~ =  Root Panel
4
-*—'D masterPage2 =
5[ pagel % > = Employee
= D employee
4 line > = Expenses
-{T] subHead |
firstName 3
{1 lastMame 5 = Signature
= clientMName i-
otherClientName =
] notes > = Review
=5 expenses
= header
[T subHead > ,2 Toolbar

The child objects of a subform can be positioned or flowed within the subform. You control this with the Content
property of the subform. Subforms can be set to Positioned which will enable you to place your child objects on an
X/Y grid relative to the subform. Subforms can also be set to Flowed and there are 3 different flow directions for the
child objects: Top to Bottom, Western Text, and Right to Left. You will see each of these examples in the exercises.

Subforms work in conjunction with the content areas that you learned about earlier. Content areas control where
objects are located, and subforms control how objects are placed as the form is rendered. By grouping certain
objects together in a subform, you can be assured that they'll be consistently positioned relative to each other as the
form is rendered.

Depending on the incoming data or the user interaction, subforms can be repeated, expanded, or hidden. Repeating
and expanding subforms are ideal for forms with repeating data like the SmartDoc Expense Report. Repeating
subforms are child subforms that are placed inside an expanding parent subform. Because subforms are separate,
independent sections of a form, they can be hidden or shown based on the needs of the user or other business logic.

Subforms can be challenging and complex, but they are what make dynamic documents dynamic. Without
subforms and tables, which are just a type of subform, you wouldn't be able to create dynamic documents that grow
and shrink based on data or user interaction.

Hidden and invisible subforms

You can hide and show subforms by setting the Presence property. The three most common values for the Presence
property are Visible, Hidden (Exclude from Layout), and Invisible. Depending on the option you choose for the
Presence property and the Content property of the parent subform, different effects will result.
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bodyPageSubform
Flowed (Top to Bottom)

bodyPageSubform
Flowed (Top to Bottom)

childSubformA
Presence (Visible)

childSubformA
Presence (Visible)

childSubformB
Presence (Visible)

childSubformC
Presence (Visible)

childSubformC
Presence (Visible)

bodyPageSubform
Flowed (Top to Bottom)

bodyPageSubform
Positioned

O

childSubformA

Presence (Visible)

Presence (Visible)
@——— Presence (Invisible)

childSubformC

childSubformB

childSubformA
Presence (Visible)

Presence (Hidden) ——@

childSubformC
Presence (Visible)

Consider the four scenarios illustrated here.

— In example #1, the parent is set to Flowed and all children are set to Visible.

— Inexample #2, the parent is also set to Flowed but childSubformB is set to Hidden (Exclude from Layout). This will
cause childSubformC and all subsequent subforms to automatically move up in the form to occupy the position
previously held by childSubformB.

— In example #3, the parent is also set to Flowed but childSubformB is set to Invisible. It is true that childSubformB
has disappeared but notice that childSubformC hasn't moved up like it did in the previous example. An object
set to Invisible will still retain its place in the layout, it will simply not appear.

— In example #4, the parent is now set to Positioned so all child subforms will maintain their X and Y position
relative to the parent. Even when childSubformB is set to Hidden (Exclude from Layout) childSubformC will not
move up. A subform is only truly hidden when its parent is set to flowed.

Notice that childSubformB is set to Invisible in Example 3 and Hidden in Example 4, but the end result is the same.
The gap in Example 4 is caused by the parent subform'’s Positioned setting.

Pagination and Subform Flow Is Different in HTML Forms

Pagination and subform flow work differently in the HTML renderings of your Designer files than they do in the PDF
renderings. For instance, the repeating expense rows of the SmartDoc Expense Report will flow from page to page in
a PDF rendering of the form. However, in the HTML rendering, these repeating rows will simply repeat on the same

HTML page without flowing to a secondary page.

Tables

Tables in Designer are a lot like tables in a word processing program. You can use tables to organize data into a
structured grid of related objects. But in Designer, tables are also complex container objects, so you can work with
them just like you work with subforms.

The Table menu and Table object
You can add a simple table to your form in either of the following ways.
—  Click the Table menu and select Insert Table (left)

— Drag and drop a Table object from the Standard Object Library onto your form (right)
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Table | Layout Tools Window Object Library IZI\ Fragment Library
¥  Standard =
I=  Insert Table.. .
Insert R (=5l Button Check Box @ Circle [@Content Area
£ Date Field EDate/Time Field JDecimal Field =1signature Field
3
Delete .;'IjDrop-down List  [EEEmail Submit Button EEHTTP Submit Button
Select L [Eimage {1mage Field / Line [EList Box
Merge Cells ENumeric Field #0paper Forms Barco; Epassword Field
(=] pri i [2k]
Mark Header :_D.Prmt Button @Radm Button Rectangle Reset.Button
Split Cell Horizontally v S.ubfor.m T Text Text Field
@ﬂme Field - ]
Distribute Rows Evenly {&signature Scribble

In both cases, Designer will launch the Insert Table dialog box (see illustration).

Insert Table

(@) Create Simple Table: ol

Columns: 3
Cancel

A e[

I
E

Body Rows: g
Help
Include Header Row in Table

|:| Include Footer Row in Table

._'_:'_u Create Table Using Assistant

Dgon't Show Again

The Insert Table dialog box enables you to create a simple table or to launch the Table Assistant.

The Table Assistant

The Table Assistant is a multipage wizard tool, and it provides more features and additional information about
tables. One of the additional tools in the Table Assistant is the Row Shading page, which enables you to set different
colors for alternating rows. This is a useful design method to use on your forms. Changing the colors on alternating
rows makes it easier for your users to read and comprehend table-based data.

Exercises

In these exercises, you will work with dynamic forms. Because these forms are dynamic, it's best to test them with
sample data files to see how they will expand and contract. Ideally, you will test them with more than one data file
to show different runtime possibilities.

The Expense Report with Dynamic Subforms

1. Select File - Open and navigate to your Student Files.
2. Select expenseReportCompleted.xdp and click Open.
3. Select File - Form Properties. Designer opens the Form Properties dialog box.

4. Select Preview and click the Browse icon (see illustration) to right of the Data File field.
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Form Properties

£xd

ComEatibilii

Info Preview Type: |Interactive Form " l Generate Preview Data...

)

Defaults

Run-time
Formatting
Default Fonts

Data File:

Preview Adobe XML Form As: IDynamic XML Form

Form Validation

ICg)|

| Browse... I

Server

Variables

FDF Security
FDF Print Options

Save Options

Data Binding
5. Navigate to your Student Files.
6. Select expenseDataShortxml and click Open.
7. Click OK to close the Form Properties dialog box.
8. Select Preview PDF to see the expense report fill with data. You should see 2 pages of expense report data.
Receipt  Date Category Description Cost #of Total
Yes []08/01/2000 Transportation -] Train ticket to New York $16.00 1 $16.00
No [-]08/01/2009  Meals [+| Breakfast with client §10.00 1 $10.00
Yes []08/02/2009 Transportation  [+]Taxi to office $15.00 1 $15.00
9. Select Design View to close the PDF preview.
10. Select File - Form Properties again.
1. Select Preview and click the Browse icon to right of the Data File field.
12. Navigate to your Student Files.
13. Select expenseDatalLong.xml and click Open.
14. Click OK to close the Form Properties dialog box.
15. Select Preview PDF to see the expense report fill with data. You will see more pages and more expense rows.
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SmartDoc tecunoLocies™ Expense Report
Date Requested: 08/27/2014
Employee
Lastam Cllent Nome Other Cllent Name
Terry Other Fidelity ‘
This -Business team and Natic 'on Summer Street
Expenses
Receipt _ Date Cotegory Desaiption cost #of Total
Yes 08/26/2014 |Transportation Plane ticket (AirTran) to Detroit, Michigan $17421 [ 1 $174.1
Yes 08/26/2014 ‘Ludgmg .Hahdaylnn I $15662 | 1 I $156.62
Ves | 081262014 |Meals [Dinner 51900 | 1 51900
Yes 08/26/2014 ‘Mea\s >BYEE kfast $6.00 | 1 | $6.00
Yes | 08/26/2014 [Transportation _[Taxito Ford Motor Headquarters 59091 5909
Yes 08/26/2014 ‘Men\s vsna:ksand drinks $3.00 | 1 I $3.00
Yes 08/26/2014  |Meals lLunch $7.00 | 1 $7.00
Yes | 08/26/2014 |Transportation |Taxi to Holiday Inn 5909 1| 59.09
Yes 08/26/2014 ‘Mea\s >DWHEI $15.00 | 1 | 515.00
No | 08/26/2014 |Phone/Fax ICall to SmartDoc Bejing 5200 1 5200
Yes 08/26/2014 ‘Ludgmu .Hahdaylnn night 2 $15662 | 1 I $156.62
Yes 08/26/2014 |Meals Breakf $8.00 | 1 $8.00
Ves | 08262014 [Transportation  |T: d Motor Headaquarters 909 1 | $9.00
Ves | 08/26/2014 |Meals 5000 1 5900
Yes | 08/26/2014 |Transportation [Taxi to Holiday Inn 5909 1| $9.09
Yes 08/26/2014  |Meals Dinner $13.00 [ 1 $13.00
Yes | 08/26/2014 |Lodging Holiday Inn night 3 $15662 | 1 $156.62
No 08/26/2014 |Phone/Fax [Call to SmartDoc New Jersey 5400 | 1 $4.00
Yes | 08/26/2014 |Meals Breakfast $7.00 | 1 $7.00
Yes | 08/26/2014 [Transportation __|Taxito Ford Motor Headquarters 9091 5909
Copyright 2020 - SmartDoc Technologies

16. Select Design View to close the PDF preview.
17. Select the Hierarchy panel if it is not already selected.

18. Expand the hierarchy by selecting page 1 - expenses - expensesWrapper - expenseRow (see illustration).

Receipt Date Category. Description Cost #of Total

ves | 082772014 [Transportation _[plane ticket (AifTran) to Devvoit Michigan | $17421| 1| $17421
Yes | 0872772014 |Lodging Holiday Inn 515662 | 1 515662
Yes | 08/27/2014 |Meals Dinner $19.00 | 1 $19.00|
Yes 08/27/2014 |Meals Breakfast $6.00 | 1 $6.00
Yes | 0872772014 [Transportation __|Taxito Ford Motor Headquarters 59091 5909
Yes 08/27/2014 |Meals [Smacks and drinks $300 | 1 $3.00
Yes I 08/27/2014 |Meals Lunch $7.00 I 1 $7.00
Ves | 0872772014 [Transportation |Taxito Holiday Inn 59091 5909
Ves | 0872772014 |Meals Dinner $1500 | 1 51500
No | 08/27/2014 |phone/Fax |call o SmartDoc Bejing 5200 1 5200
Ves | 0872772014 |Lodging Holday Innnight 2 sises2| 1| s1s6e2
Yes | 0872772014 |weals Brealast s800 1 5800
Yes | 0872772014 [Transportation __|Taxito Ford Motor Headquarters 59091 5909
Yes | 0872772014 |Meals Lunch 5900 1 5900
Yes | 08/27/2014 [Transportation Taxi to Holiday Inn 5909 | 1 $9.09
Yes I 08/27/2014 |Meals Dinner $13.00 | 1 $13.00]
Yes | 082772014 |Lodging Holiday Inf night 3 15662 | 1 $15662
No | 0872772014 [phone/Fax Call to SmartDoc New Jersey 5400 1 5400
Ves | 0872772014 |Meals Brealdast 700 1 §7.00
Yes | 08/27/2014 [Transportation Taxi to Ford Motor Headquarters 5909 | 1 $909
Sub Total: $751.00

Less Cash Advance: $.00

Copyright 2020 - SmartDoc Technologies

TOTAL -5751 .00

Page 2.0f 2

E—Jlj pagel
[

T employee
expenses
header
expensesWrapper
= columnHeaders

expenseRow|

EXPEI‘ISES

Receipf]

Date]

Category|

Description|

Add Expense

19.

20.

With expenseRow selected, select the Binding tab of the Object palette.

why the form is dynamic. An expenseRow is created for each Expenseltem.

21

22.

23.

Select the Subform tab of the Object palette.

Select expensesWrapper (the parent of expenseRow).

Notice the expenseRow has a data binding of $.Expenseltem[*] and is set to repeat for each data item. This is

Notice the expensesWrapper is set to Flowed with a Flow Direction of Top to Bottom. This will also be true for the

parent subform (expenses) and the grand-parent subform (pagel). A body page is just another subform.

24,

25.

downwards to make the editor larger.

AEM Forms Designer - 28

Select the addExpense button. The button’s caption is Add Expense.
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Expand the Script Editor by selecting the handle outlined in red (see illustration) and dragging the window




Show Events dropdown

E Show:  click® : ‘ fuﬁ| Language: JavaScript ¥ Run At: Client - Enable Event Propagation
ex;ZE je1.expenses.expensesWrapper.addExpenseWrapper.addExpense::click - (JavaScript, client) -
q EESE

2expenseRow.instanceManager.addIinstance(1);
3 xfa.form.recalculate(true);

For Help, press F1 [ Line: 1 Col: 1

Script Editor handle

26. Click the Show Events dropdown (see illustration above) and select the click event.

27. You will see the script that creates a new instance of the expenseRow.

expenseRow.instanceManager.addinstance(1);
xfa.form.recalculate(true);

The Dynamic Insurance Form

28. Select File - Open and navigate to your Student Files.
29. Select dynamiclnsuranceForm.xdp and click Open.
30. Select Preview PDF to see the form in action.

31. Select the different types of insurance policies (see illustration).

SmartDoc rechnoLocies
Dynamic Insurance Form

[ ]Universal Life (UL) [ JTraditional Life (TL) [ ]Vvariable Universal Life (VUL) X|Health

32. Notice the dynamic options will change each time you select a different insurance policy.

33. Click Design View to close the preview.

Subforms and Flow
As with other Designer features, subforms are easy to understand if you look at an example.

34. Select File - Open and navigate to your Student Files.
35. Select basicSubform.xdp and click Open.

36. With the bodyPageSubform selected (left), click the Subform tab of the Object palette (right).

37. Notice the Content property is set to Flowed and the Flow Direction is Top to Bottom. This property governs

the 4 child subforms. Subforms A, B, C, and D will be Flowed, Top to Bottom.
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| Hierarchy IZI\ Data View | Object IZI\Layout \ Accessibility \Border

SN t

J Subform \Pagination \Binding

«EI

=-[E formi Content:  [F G -

HJ (Master p
B ( aster Pages) Flow Direction:  Top to Bottom hd

D page1
(=R} bodyPagesubform [¥] Allow Page Breaks within Content
= subforma

[ | This Subform is an Insertion Point

Name:

38.

39.

40.

41.

42.

43,

Select subformA and notice its Content property is set to Positioned. The child objects of subformA will be
positioned exactly where you place them in Design View. Each child object will maintain its X and Y position
relative to subformA regardless of where subform A appears on the rendered form.

Select subformB and notice its Content property is set to Flowed and the Flow Direction is Top to Bottom, just
like bodyPageSubform. The child objects will be flowed in the layout according to their position in the hierarchy.

Select subformC and notice its Content property is set to Flowed and the Flow Direction is Western Text. The
child objects will be placed left to right and wrapped onto the next line if more space is required.

Select subformD and notice its Content property is set to Flowed and the Flow Direction is Right to Left. The
child objects will be placed right to left and wrapped onto the next line if more space is required.

Select subformB and notice its Presence property is set to Visible.

Click the Presence property dropdown and select Hidden (Exclude from Layout).

subformA (Positioned) |

‘ Object \E!\Layuut \ Accessibility \Bnrder

w J Subform \‘\Fagmation \Bmding
Text Field Content:  Flowed -

Flow Direction:  Top to Bottom -

|] Allov Page Breaks within Content
Visible
Visible (Screen Only)
Visible (Print Only)
Invisible

[] Check Box

Hidden (Exclude from Layout)

subformC (Flowedeestern TEXU Button Inactive (Exclude from Form Processing)

[[] Check Box Text Field One-sided Printing Only
Twao-sided Printing Only

Hidden (Exclude from Layout) B

Button subformD (Right to Left) Locale:

fault locale -
) :| [[] Check Box be
Text Field | ‘ English (USA)

The form content below subformB will now move up because the parent (bodyPageSubform) is set to Flowed and
the Flow Direction is Top to Bottom.

44,

45.

46.

Select subformB again and change its Presence property to Visible.
Select bodyPageSubform and change its Content property is set to Positioned.

Select subformB and change its Presence property back to Hidden (Exclude from Layout). This time, the form
content below subformB does not move up because the parent (bodyPageSubform) is set to Positioned.
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subformA (Positioned) |

Object =™, Layout Accessibility Border
. \ 2N AN AN

J Subform \Paqmabnn \Binding

Text Field Content:  Flowed -

Flow Direction:  Top to Bottom -

D Check Box [] Allow Page Breaks within Content
Visible

Visible (Screen Only)

Visible (Print Only)

Invisible

Hidden (Exclude from Layout)

Inactive (Exclude from Form Processing)

One-sided Printing Only
Twao-sided Printing Only

Hidden (Exclude from Layout) E

subformC (Flowed-Western Text) Button Lt =

I
[[] Check Box

Default locale -
Text Field English (USA)

Note: Remember, it is always the parent that controls the layout of the child objects.

Create a Simple Table
Follow these steps to create a simple table.

1. Select File - New. Designer launches the New Form Assistant.

2. Select Use A Blank Form. This is the default.

3. Click Next to continue.

4. Keep the defaults, and click Finish to create your new form.

5. Select the Table menu. The Table menu is on top, and it provides many tools for working with tables.
6. Select Insert Table and you will see the Insert Table dialog box.

7. Keep the default of Create Simple Table and select the Include Header Row in Table and the Include Footer
Row in Table options (see illustration).

Insert Table *

(®) Create Simple Table:
Columns: 3
Body Rows: 1

Include Header Row in Table
Incude Footer Row in Table

Cancel

L1 (L (NIRJIL

Help

(") Create Table Using Assistant

8. Click OK

9. Designer will create a simple table in the Layout Editor (see illustration).
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10. Double-click on each Header and change their names so you have a column for First Name, Last Name,
and Email (see illustration).

[ Design View | || Master Pages  ®| [ XML Source 3| % Preview PDF =) [ Preview HTML B
<2 B PI EPRR s

Hierarchy = {_Data View =
Q| It 3

B|ﬂ form1 2 |
—-{ [ (Master Pages) B
|

|1

!‘@ (untitled Content Area) -
=] \j [untitled Subform} (page 1} 1
=8 Tablel b

E-EH HeaderRow T . e
= T cent i First Name Last Name Email|

Cell2
corc) ]
w1
Calll
Cellz
Ccell3
oterRow —
cen 4
AT cenz g
T Cell3
w-i¥l), [Referenced Objects) —

=]

Footer Footer Footer

=-E

EE I EEEzEEE

B

1. Expand RowT1 in the Hierarchy palette (see illustration on the left) and you will notice that the form object in each
cell is a Text object.

12. Select the Celll text object and change its type to Text Field. You can do this in the Type property of the Object
palette (see illustration on the right).

| Hierarchy @\ Data View -
Q T | object =_Accessibility
Cell ™,
E|-E_| form1
=MD (Master Pages) Type: [T Text -
E Text Field
P (untitled Content Area) Allov[E] Numeric Field
=-[ (untitled Subform) (page 1) Keep [ Decimal Field
=N [=+] Password Field
=] E Tablel This o . :
B HeaderRow (&9 Date/Time Field
; Rowl [#] Signature Field
[oK]
i celi -Euttu.n .
[T cellz [25] Email Submit Button
]
“|m) cella [EEHTTP Submit Button
e [54] Print Rutton

13. Select Cell2 and Cell3 and set their Type properties to Text Field so every cell in Row1 has a Text Field input.
14. Click Cell3 and select the Layout palette.
15. Enter 2.5 for the Width. This will enable you to enter longer email addresses.

16. Click Preview PDF and enter your name and email address into the first row.

[ Design View | Master Pages  ®| @ XML Source = % Preview PDF =| & Preview HTML =
First Name Last Name Email Address
James Terry jp@smartdoctech.com

17. Select Design View to close the PDF preview.
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18. Right-click on the Table1 object in the Hierarchy palette (see illustration) and select Rename Object.

Hierarchy =" Data View _ [ Design View | Master Pages
Q t‘1—|D.|I.|.|1.|.I.|.|2.|.I.|
BE formi o D__ .......................

D (Master Pages) B R
EiDpager A
P (untitled Content Area) 1 L
Bﬁ {untitled Subform) (page 1) 14 I
=Tk Table 1 ] S
I HeaderRow ] BN

19. Enter SimpleTable for the name.

Use the Table Assistant

Follow these steps to create a more detailed table with the Table Assistant

20. Click the Table menu and select Insert Table.

21. Select Create Table Using Assistant (see illustration) and click OK.

22. Select 3 Columns and 5 Body Rows (see illustration).

Insert Table @ Table Assistant @
@ Create Simple Table: Steps (@ Bogy s Exed Dimensions Preview (35%)

Columns: 3 1. Body Layout Number of Columns: 3 :
Body Rows:  ° 2. Header Row Number of Body Rows: 5 —
. 3. Footer Row =

Include Header Row in Table

Include Footer Row in Table

4. Sections

5. Row Shading

() Body Rows Vary Depending on Data

2l

Layout: Left to Right Rows

23. Click Next.

24. Select Has Header Row and click Next.
25. Select Has Footer Row and click Next.
26.
27.

28.

Select Has Body Rows And No Sections and click Next.
Select Alternating Row Colors and select a Gray-25% for the First row.

Select white for the second row. This should be the default.
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Table Assistant @

Steps Alternating Row Colors

Preview (35%)
1. Body Layout First: 1 ~ Rows
2. Header Row EENEEEEEN
Mext: 1 2 Rows EEEEEEEN
3. Footer Row u N R |
Heacer Huader
4. Sections - = = .D |

5. Row Shading

29. Click Finish.
30. Select the Layout palette if it is not already selected.

31. Enter an AnchorX and an AnchorY value so your new table does not overlap your SimpleTable.

- X

Object j Layout IEI\J\BDrder \J\Accessibil'rty

Size & Position

Anchory: | |1.3437in Anchor':
Auto-fit Auto-fit

Anchar: | Top Left ~

32. You now have a table with alternating row colors (see illustration).

(v
~ Header Header Header
Footer Footer Footer

The Expense Report with a Dynamic Table

Follow these steps to see how a dynamic table is similar to the dynamic subforms in the SmartDoc Expense Report.

1. Select File - Open and navigate to your Student Files.

2. Select ExpenseReport2020_finished.xdp and click Open.

3. Select File - Form Properties.

4. Select Preview and click the Browse icon to right of the Data File field.

5. Navigate to your Student Files.
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6. Select the ExpenseReport2020_3records.xml file and click Open.
7. Click OK to close the Form Properties dialog box.

8. Select Preview PDF.

9.

Click the Add an Expense button and notice it has the same functionality as the other dynamic expense report.

Week Of: Category Description Receipt Amount
03/21/2021 Meals EI Starbucks coffee and breakfast Yes EI 12.00
03/21/2021 Lodging EI Hilton Hotel Yes EI 225.00
03/21/2021 Meals EI Panera Yes EI 15.00

Add Expense

10. Select Design View to close the PDF preview.

1. Expand the expenses subform in the Hierarchy palette.

12.  Expand the expensesWrapper table so you can select the expenseRow table row.

13.  With expenseRow selected, select the Binding tab of the Object palette.

14. Notice the expenseRow has a data binding of $.Expenseltem[*] and is set to repeat for each data item. This is
exactly the same as the previous example with the dynamic subforms.

15. Select the addExpense button. The button’s caption is Add Expense.

16. Expand the Script Editor by selecting the handle outlined in red (see illustration) and dragging the window
downwards to make the editor larger.

Show Events dropdown
E Show: dlick™ : ‘ ﬁﬁ| Language: JavaScript ¥ RunAt: Client - Enable Event Propagation
ex;Ze je1.expenses.expensesWrapper.addExpenseWrapper.addExpense::click - (JavaScript, client)
1

2expenses.expenses\Wrapper.expenseRow.instanceManager.addInstance(1);
3

For Help, press F1

Line: 1

Col: 1

Script Editor handle

17.  Click the Show Events dropdown (see illustration above) and select the click event.

You will see the script that creates a new instance of the expenseRow.

expenses.expensesWrapper.expenseRow.instanceManager.addinstance(1);
xfa.form.recalculate(true);

Note: This script is slightly different than the other addinstance script. In this case, we need to go further up the
hierarchy to the common expenses node in order to create a proper reference to the expenseRow table row. You will

learn more about creating references in the Scripting section.
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Templates, Objects, and Fragments |

It is a best practice to create your forms based on Designer's templates, custom objects, and fragments. Each of these
enables you to create standardized components that you can use multiple times in your form system.

Preview: e
Object Library =Y, £ tLib
Use a blank form | ] forary ragment Library =
iw  SmartDoc Technologies =, -
atemplate 1
— . [l addExpense [addressChangeField [ JaddressChangeField —
1 5 =
s8d on a spreadshee addressChangeHeader =lladdressChangeState
Imperta PDOF document addressinformation D‘{appruvaISection e approvalStatus

Import a Microsoft Word document i Farrow chaptinnDrchnwn [ eaptionField i columnHeaders -
%

[ object Library " Fr Library =

i
» T

i [ SmartDoc Fragments

addressChangeHeader

m

addressInformationFragment

i g employee

You will achieve form consistency through the use of reusable components. And you will achieve management
efficiency because you can make updates once and have them automatically propagate through your form system.

Templates

Designer enables you to create a new form based on a template. You can use the out-of-the box Designer templates
or create your own custom templates. Templates enable you to set layout properties across many forms or
documents. Templates can be used to standardize the following aspects of your forms.

— Layout properties, including page size, margins, headers, and footers
—  Graphic design properties, including font, color, and style

—  Common script objects and form variables

Steps Getting Started
1. Getting Started Select a method for creating a form:
2. Document Setup Use a blank form

@/Basedona Iemplate‘i
Based on a spreadshest
Import a PDF document

Import 2 Microsoft Word document

Custom Objects

In addition to custom templates, Designer also enables you to create custom objects for use in your forms. Designer
supports the creation of custom objects and custom object libraries. You can create the perfect interface object with
the font you want and functionality you need, and then save it for reuse on any form.
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-
| Object Library &, Fragment Library { Object Library palette menu
{»  Standard
*  Custom =
B address Block SForm Bridge i countries 23 current Date Add Library Group @
Zipata Drop-down List EfData List Box [EJEmail Address
E_-E;’Insemon Point uMaster Page n of m uNamE Name: SmartDod
npage MNavigation Bpage nof m [Iphone Number - UK
[Iphone Number - North America uProcess Fields osheet nofm [ 0K ] ’ Cancel ]
[T]signature - Print and Sign [S subform Instance Controls: Add
{™* subform Instance Controls: Insert Remove Move @ survey Question
[Ju.s. social Security Number Hu.s. states

You can create the perfect interface object with the font you want and functionality you need, and then save it for
reuse on any form. A custom object can include design elements, data bindings, and JavaScript functionality. You can
organize your objects in custom object libraries. You will create a SmartDoc object library in the exercises. The
Object Library palette menu is represented by a very small dropdown icon in the upper-right of the Object Library
palette, as shown here.

Form Fragments

You can take the standardization concept one step further with form fragments. Fragments enable you to create a
section of a form and reuse it across many different forms. A form fragment will appear with a purple tint in Design
View and the objects will be grayed-out in the Hierarchy palette (see illustration).

E-E

eApp
' Master

‘ApplicationPage|

[

EB:ount Type: [ | Checking [[_] Savings]
G establish electronic payments from
some brokerage, mutual funds or from foreign
bank accounts (unless it is being paid in U.S.

1000

Dollars through a U. S. bank.) R I8
Banking institution routing number ‘ e B B
Account number i
©00000018k: 000000529 1000
lame of bank \—|—| [—|—|
: z structionsCallou
~{T Instructions f this is a brokerage account, please provide firm name

Imagel1[0]

The following points are true about form fragments.

— Allinstances of a form fragment are exactly the same because each is only a reference to one master form
fragment (which is saved as a separate XDP file).

—  When the form fragment is updated, all forms that use the fragment are updated automatically.

— Form fragments enable you to manage and maintain a library of forms more efficiently and effectively. You'll no
longer need to execute and test the same change across many forms.

— If you do need to edit and change an instance of a form frag